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BAB III 

METODE  PENELITIAN 

 

A. Desain Penelitian 

Desain penelitian yang digunakan dalam penelitian ini adalah desain 

faktorial. Fraenkel dkk. (2012, hlm.  277) menerangkan:  

… it is possible using a factorial design to assess not only separate effect 

of each independent variable but also joint effect.  In other words, the 

researcher is able to see how one of the variable might moderate the other 

(hence the reason for calling these variable moderator variables). 
 
Ini memungkinkan penggunaan desain faktorial untuk mengkaji bukan 

hanya memisahkan pengaruh dari setiap variabel bebas tetapi juga pengaruh dari 

penggabungannya.  Dengan kata lain, peneliti dapat melihat bagaimana salah satu 

variabel menjadi penengah yang lainnya (alasan untuk menyebut variabel ini 

sebagai variabel moderator). Lebih lanjut lagi Fraenkel dkk. (2012, hlm. 277) 

menyatakan bahwa desain faktorial merupakan modifikasi dari desain posttest-

only group atau pretest- posttest control group sebagai berikut: 

Factorial designsextend the number of relationships that may be examined 

in an experimental study. They are essentially modifi cations of either the 

posttest-only control group or pretest-posttest control group designs (with 

or without random assignment), which permit the investigation of 

additional independent variables. 
 

Dalam penelitian ini  akan mengkaji interaksi antara model pembelajaran 

dan gender sehingga dikembangkan menggunakan faktorial. Adapun desain yang 

dikembangkan akan digambarkan sebagai berikut:  

Tabel 3.1. 

Desain Faktorial 2x2 

 

Model 

Permanian  

Tradisional 

Gender  

Model TGFU 

A1 

Model TGT 

A2 

Laki-Laki B1 A1B1 A2B1 

Perempuan  B2 A1B2 A2B2 

Keterampilan Permainan Tradisional 
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Keterangan: 

A1 

A2 

B1 

B2 

A1B1 

A2B1 

A1B2 

A2B2 

= 

= 

= 

= 

= 

= 

= 

= 

Model pembelajaran TGFU 

Model pembelajaran TGT 

Gender Laki-laki 

Gender Perempuan 

Model pembelajaran TGFU gender Laki-laki 

Model pembelajaran TGT gender Laki-laki 

Model pembelajaranTGFU gender perempuan 

Model pembelajaran TGTgender perempuan 

B. Partisipan 

Pelenitian ini melibatkan siswa sekolah dasar kelas 5 sebagai 

partisipannya. Tempat pelaksanaan penelitian adalah Sekolah Dasar Negeri 

Panyingkiran I. Program pada penelitian ini akan dilaksanakan 3 kali pertemuan 

dalam seminggu, sesuai dengan pendapat juliatine, dkk (2007 hlm. 3.5) 

mengatakan bahwa “sebagai percobaan untuk mendapatkan hasil yang baik bisa 

pula dilaksanakan dalam frekuensi latihan 3 hari/seminggu, sedangkan lamanya 

latihan paling sedikit 4-6 minggu”. Oleh sebab itu peneliti melakukan pertemuan 

sebanyak 3 kali dalam seminggu yaitu hari senin, rabu, dan jum’at. Menurut 

Brooks dan Fahey (1984, hlm. 405) menyatakan “bahwa pembelajaran dengan 

frekuensi 3 kali seminggu akan terjadi peningkatan kualitas keterampilan, karena 

dengan pembelajaran pembelajaran 3 kali seminggu akan memberikan 

kesempatan bagi tubuh untuk beradaptasi terhadap beban pelajaran yang 

diterimanya”. penelitian ini dilakukan 16 kali pertemuan adalah menyesuaikan 

dengan jadwal kegiatan siswa SD Negeri Panyingkiran I. selain itu sampel yang 

digunakan adalah siswa SD Negeri Panyingkiran I yang dominan memiliki tingkat 

keterampilan rata-rata, yang dikhawatirkan jika frekuensi latihannya lebih banyak 

akan terjadi kelelahan yang berlebihan sehingga akan berakibat buruk bagi anak 

itu sendiri. Dalam proses penelitian, sesuai dengan apa yang disampaikan di 

dalam penelitian Gantara (2013, hlm. 44) menurut Sarwono & Ismaryanti (1999, 

hlm. 43) bahwa :  

“Frekuensi jumlah waktu ulangan latihan yang baik adalah dilakukan 5-6 per sesi 

latihan atau 2-4 kali per minggu”. 
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5 sesi X 2 kali perminggu = 10 kali pertemuan. (minimal) 

5 sesi X 3 kali perminggu = 15 kali pertemuan. (sedang) 

5 sesi X 4 kali perminggu = 20 kali pertemuan. (maksimal) 

  

C. Populasi dan Sampel 

1) Populasi 

Pengertian populasi menurut Sugiyono (2012, hlm. 80) adalah “Wilayah 

generalisasi yang terdiri atas objek atau subjek yang mempunyai kualitas dan 

karakteristik tertentu yang ditetapkan oleh peneliti untuk dipelajari dan kemudian 

ditarik kesimpulannya”. Populasi penelitian ini adalah semua siswa laki-laki 

dan siswa perempuan kelas 5 SD Negeri Panyingkiran I, Kecamatan 

Panyingkiran, Kabupaten Majalengka Tahun Pelajaran 2016/2017, dengan 

jumlah 20 siswa yang terdiri dari satu kelas dengan rentang usia 10-12 tahun. 

Alasan pemilihan  kelas 5 SD Negeri Panyingkiran I karena murid-murid SD 

kelas 4 sampai 6 program pendidikan jasmani menjadi ajang untuk bergembira 

dan mempelajari keterampilan dan kemampuan keterampilan bermain untuk siswa 

kelas 5 SD Negeri Panyingkiran I dalam kategori kurang baik. 

2) Sampel 

Sampel adalah sebagian atau wakil populasi yang akan diteliti. 

Menurut Sukmadinata (2012, hlm. 250) “sampel adalah kelompok kecil yang 

secara nyata kita teliti dan tarik kesimpulan”. Roscoe yang dikutip Uma 

Sekaran (2006) memberikan acuan untuk menentukan ukuran sampel 

penelitian eksperimental sederhana dengan kontrol eksperimen yang ketat, 

penelitian yang sukses adalah dengan ukuran sampel kecil antara 10 sampai 

20. Teknik pengambilan sampel dalam penelitian ini menggunakan teknik 

nonprobability yaitu sampel jenuh atau sering disebut total sampling maka 

jumlah sampel dalam penelitian ini adalah 20 sampel yang merupakan total 

dari jumlah siswa kelas 5 SD Negeri Panyingkiran 1 Majalengka, seperti yang 

dijelaskan Sugiyono (2012, hlm. 81) bahwa, “teknik sampling adalah 

merupakan teknik pengambilan sampel, dalam hal ini penulis menggunakan 

sampling jenuh”. Sampling jenuh menurut Sugiyono (2012, hlm. 85) 

“sampling jenuh adalah teknik penentuan sampel bila semua anggota populasi 

digunakan sampel”. Penentuan siswa yang akan tergabung dalam model 
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pembelajaran TGFU dan model pembelajaran TGT dilakukan dengan 

menggunakan random sampel sederhana. Menurut Fraenkel and Wallen (1993, 

hlm.82) “a simple random sample is one in which each and every member of the 

population has an equal and independent chance of being selected”. Dengan kata 

lain, dalam random sampel sederhana ini semua anggota memiliki kesempatan 

yang sama untuk terpilih.  

Langkah-langkah dalam simple random sampling ini terdiri dari : 

a) Menentukan populasi. 

b) Mendaftar semua anggota populasi. 

c) Memilih sampel dengan menggunakan sebuah prosedur yang menentukan 

anggota mana pada daftar tersebut yang akan diambil sebagai sampel. 

Dalam penelitian ini, teknik sampel random sederhana digunakan untuk 

menentukan siswa mana  yang akan tergabung kedalam kelompok kelas 

eksperimen model pembelajaran TGFU dan model pembelajaran TGT dengan 

langkah-langkah sebagai berikut: 

1. Menentukan populasi dalam penelitian, yaitu siswa kelas 5 SD Negeri 

Panyingkiran 1 dimana seluruh populasi ini juga menjadi sampel dalam 

penelitian. 

2. Mendaftar semua siswa kelasa 5 SD Negeri Panyingkiran 1. Daftar siswa ini 

dituliskan di kertas kecil, dimana satu kertas untuk satu nama siswa. 

3. Setelah mendaftar seluruh siswa kelas 5 SD Negeri Panyingkiran 1, kemudian 

dipisahkan nama siswa laki-laki dan nama siswa perempuan. Seluruh nama 

siswa laki-laki dimasukkan dalam botol pertama dan seluruh nama siswa 

perempuan dimasukkan dalam botol kedua. Kemudian dilakukan pengundian, 

dimulai dari botol pertama untuk siswa laki laki, 5 kertas pertama yang keluar 

dari botol tersebut akan masuk menjadi kelompok kelas model TGFU, dan 

sisanya 5 kertas yang tersisa didalam botol tersebut bergabung menjadi 

kelompok kelas model TGT. Hal yang sama juga dilakukan dalam 

pengundian siswa perempuan, dimana 5 kertas pertama yang keluar dari botol 

tersebut akan masuk menjadi kelompok kelas model TGFU, dan siswanya 5 

kertas yang tersisa dalam botol menjadi anggota kelompok kelas model TGT. 

Sehingga, terpilih lah 5 siswa laki-laki dan 5 siswa perempuan untuk kelas 
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eksperimen dengan model pembelajaran TGFU dan 5 siswa laki-laki serta 5 

siswa perempuan untuk kelas eksperimen dengan model pembelajaran TGT. 

 

D. Perlakuan atau Treatment Penelitian 

Penelitian ini dilaksanakan selama 16 pertemuan yang dilaksanakan 3 kali 

seminggu, jadi penelitian dilakukan kurang lebih selama 6 minggu. Berikut adalah 

langkah-langkah yang dilakukan dalam penelitian menggunakan model 

pembelajaran kooperatif tipe TGFU dan model pembelajaran TGT dalam 

meningkatkan keterampilan permainan tradisional. 

a. Pre Test 

Pelaksanaan pre test dilakukan sebelum perlakuan diberikan . pre test 

dilakukan untuk mengidentifikasi sejauh mana terampilan permainan tradisional 

yang telah dimiliki siswa baik pada keompok  TGFU maupun TGT. Untuk 

mendapatkan data keterampilan permainan tradisional siswa dinilai menggunakan 

instrument. Setelah data kedua kelompok diperoleh melalui instrument, kemudian 

data diolah dan diintrofeksi ke dalam skor pre test masing-masing kelompok. 

b. Ttreatment 

Perlakuan ini dilakukan sebanyak 3 kali seminggu selama 6 minggu 

berturut-turut atau dengan kata lain sebanyak 16 kali pertemuan dan sudah 

termasuk satu pertemuan pre test dan satu pertemuan Post test. Hal ini senada 

dengan yang dikemukakan oleh Nossek (1982, hlm10) “Systematic training is a 

regulary practiced training talking place serval times a week, depending upon the 

standart of a sportsman and the training period”. Latihan yang di sistematis 

adalah dilakukan secara teratur, latihan tersebut berlangsung beberapa kali dalam 

satu minggu, tergantung pada standar atlet dan periode layihan. Lebih lanjut 

mengenai masalah waktu latihan Harsono (1988, hlm.194) mengungkapkan 

bahwa “sebaiknya dilakukan 3 kali dalam seminggu dan diselingi dengan satu hari 

istirahat yang memberikan kesempatan bagi otot untuk berkembang dan 

mengadaptasi diri pada hari istirahat tersebut”. Jadi dapat dikatakan bahwa 

treatment di berikan sebanyak 16 pertemuan karena ingin melihat lebih jelas 

peningkatannya. Ini merujuk dari penelitian sebelumnya Bayrakatar (2010) yang 

melakukan penelitian tentang penggunaan pembelajaran kooperatif selama 12 
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pertemuan kelas senam memiliki pengaruh yang signifikan terhadap keberhasilan 

akademik siswa, sikap, dan keterampilan latihan. 

Berikut ini merupakan program perlakuan yang diberikan dalam rangka 

meningkatkan hasil belajar keterampilan permainan tradisional melalui model 

pembelajaran kooperatif tipe TGFU dan TGT pada materi ajar permainan 

tradisional yang dilakukan sebanyak 16 kali pertemuan selama 6 minggu. 

 

Tabel 3.2 Program Pelaksanaan Penelitian Model pembelajaran TGFU 

No Hari / Jam Kegiatan Pembelajaran Lokasi  

1 Senin,  14:00 – 15:30 Tes awal (pre test)  

 

 

 

 

 

 

SD Negeri 

Panyingkiran 1 

2 Rabu,   14:00 – 15:30 

Siswa melakukan permainan 

tradisional gobak sodor dan 

bebentengan 

 

3 Jumat,  14:00 – 15:30 

4 Senin,  14:00 – 15:30 

5 Rabu,   14:00 – 15:30 

6 Jumat,  14:00 – 15:30 

7 Senin,  14:00 – 15:30 

8 Rabu,   14:00 – 15:30 

9 Jumat,  14:00 – 15:30 

10 Senin,  14:00 – 15:30 

11 Rabu,   14:00 – 15:30 

12 Jumat,  14:00 – 15:30 

13 Senin,  14:00 – 15:30 

14 Rabu,   14:00 – 15:30 

15 Jumat,  14:00 – 15:30 

16 Senin,  14:00 – 15:30 Tes akhir (post test) 
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Tabel 3.3 Program Pelaksanaan Penelitian Model pembelajaran TGT 

No Hari / Jam Kegiatan Pembelajaran Lokasi  

1 Senin,  14:00 – 15:30 Tes awal (pre test)  

 

 

 

 

 

 

SD Negeri 

Panyingkiran 1 

2 Rabu,   14:00 – 15:30 

Siswa melakukan permainan 

tradisional gobak sodor dan 

bebentengan 

 

3 Jumat,  14:00 – 15:30 

4 Senin,  14:00 – 15:30 

5 Rabu,   14:00 – 15:30 

6 Jumat,  14:00 – 15:30 

7 Senin,  14:00 – 15:30 

8 Rabu,   14:00 – 15:30 

9 Jumat,  14:00 – 15:30 

10 Senin,  14:00 – 15:30 

11 Rabu,   14:00 – 15:30 

12 Jumat,  14:00 – 15:30 

13 Senin,  14:00 – 15:30 

14 Rabu,   14:00 – 15:30 

15 Jumat,  14:00 – 15:30 

16 Senin,  14:00 – 15:30 Tes akhir (post test) 

 

c. Post test 

Sudah diberikan perlakuan selama 16 kali pertemuan yang dilakukan 3 

kali setiap minggunya dengan durasi 2 x 45 menit setiap pertemuannya, 

selanjutnya sampel kembali diberikan tes keterampilan permainan tradisional, 

kemudian dianalisis untuk melihat hasil belajar keterampilan permainan 

tradisional siswa. Dan langkah terakhir hasil analisis diuji hipotesis untuk 

menjawab semua pertanyaan penelitian yang telah diajukan sebelumnya.  

 

E. Instrumen Penelitian 

Dalam penelitian ini peneliti memilih satu dari tiga komponen untuk 

mengukur keterampilan permainan tradisional merujuk Bjork & Holopainen 

(2005) sebagai berikut : 

1. Pemain yang terlibat, unsur permainan dan konfigurasi dasar. Banyak karakter 

yang ada dalam permainan dan peran yang berbeda. 

2. Tujuan dan kondisi akhir. Tujuan setiap pemain memiliki ketercapaian dalam 

permainan. Kondisi bahwa pemain menang, sementara yang lain kalah. 

3. Aturan, mode, tindakan dan peristiwa. Aturan yang menentukan seorang 

pemain atau tidak diizinkan untuk melakukan. Permainan terdiri dari berbagai 

mode sehingga aturan permainan bervariasi sesuai dengan mode. Tindakan 
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pemain yang diperbolehkan untuk melakukan sehingga untuk mengubah 

keadaan permainan. Peristiwa yang dapat timbul dari tindakan pemain. 

Tabel 3.4 kisi-kisi intrumen permainan tradisional 

No  Indikator Permainan Tradisional Sub Indikator 

1 

Pemain yang terlibat, unsur 

permainan dan konfigurasi dasar.  

a. Siswa dapat bekerjasama  

b. Membentuk keterampilan, 

kecepatan, kekuatan, kelincahan 

c. dapat berinteraksi dengan teman 

atau tim 

2 

Tujuan dan kondisi akhir.  a. siswa dapat menguasai permainan 

tradisional 

b. siswa memperoleh kemenangan 

atau kekalahan dalam permainan 

3 

Aturan, mode, tindakan dan 

peristiwa.  

a. Siswa mematuhi intruksi yang 

diperintahkan oleh guru sesuai 

dengan jenis permainan yang 

dilakukan 

 

Fokus dalam penelitian ini peneliti hanya mengambil poin satu saja 

meletakan dasar-dasar penguasaan keterampilan bermain dalam permainan 

tradisional maka komponen pengukuran keterampilan permainan tradisional yang 

digunakan dalam penelitian ini adalah pemain yang terlibat, unsur permainan dan 

konfigurasi dasar. Kemudian peneliti mengembangkan poin sub indikator menjadi 

10 poin sebagaimana yang terlampir di halaman 180 diantaranya yaitu : 
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Tabel 3.5 Pengembangan kisi-kisi intrumen permainan tradisional 

No Variable Indikator Sub Indikator 

1. Pemain 

yang 

terlibat, 

unsur 

permainan 

dan 

konfigurasi 

dasar. 

Siswa dapat 

bekerjasama  

 

A. Siswa dapat bekerjasama dengan teman 

satu tim ketika bertahan 

B. Siswa dapat bekerja sama dengan teman 

satu tim ketiika menyerang 

Membentuk 

keterampilan, 

kecepatan, 

kekuatan, 

kelincahan 

C. Siswa terampil dalam menjaga pergerakan 

lawan 

D. Siswa terampil dalam pengecoh 

pertahanan lawan 

E. Siswa mampu bergerak cepat dalam 

menggagalkan serangan lawan 

F. Siswa mampu bergerak cepat dalam 

mengecoh pertahanan lawan 

G. Siswa dapat bergerak dengan lincah dalam 

menjaga pergerakan lawan 

H. Siswa dapat bergerak dengan lincah dalam 

mengecoh pertahanan lawan 

dapat 

berinteraksi 

dengan teman 

atau tim 

I. Siswa dapat berkomunikasi secara baik 

tdengan teman satu tim ketika bertahan 

H. Siswa dapat berkomunikasi secara baik 

dengan teman satu tim ketika menyerang 

 

Kisi-kisi instrumen di atas yang dikembangkan sebelumnya perlu uji 

Coba terlebih dahulu validitas dan reabilitas instrumen yang berguna untuk 

standarisasi instrument yang akan digunakan dalam penelitian. Berikut ini hasil 

uji coba instrumen :  

Tabel 3.6 Uji Validitas Instrumen Keterampilan Permainan Tradisional 

 
Corrected Item-Total 

Correlation 
Nilai r Keputusan 

Item 1 0,489 0,30 Valid 

Item 2 0,330 0,30 Valid 

Item 3 0,606 0,30 Valid 

Item 4 0,336 0,30 Valid 

Item 5 0,556 0,30 Valid 

Item 6 0,638 0,30 Valid 

Item 7 0,316 0,30 Valid 

Item 8 0,659 0,30 Valid 

Item 9 0,512 0,30 Valid 

Item 10 0,491 0,30 Valid 
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Tabel 3.7 Uji Reabilitas Instrumen Keterampilan Permainan Tradisional 

N Cronbach's Alpha Keputusan 

10 0,806 Reliabel 

 

Tabel diatas merupakan hasil pengujian validitas dan reabilitas instrument. 

Untuk lebih jelasnya terdapat di halaman 74.  

 

F. Prosedur Penelitian 

Langkah-langkah yang akan ditempuh dalam penelitian ini dengan cara-

cara sebagai berikut: 

1. Pembuatan rancangan penelitian. 

Langkah- langkah dalam tahap ini yaitu menyusun proposal penelitian 

yang terdiri dari: 

a. Memilih masalah 

b. Pendahuluan 

c. Perumusan masalah 

d. Perumusan kerangka pemikiran dan hipotesis 

e. Pemilihan metode penelitian 

f. Menentukan sumber data 

g. Perancangan instrumen penelitian 

h. Teknik yang digunakan dalam analisis data 

2. Pelaksanaan penelitian 

Dalam tahap ini, proses yang akan dilakukan sebelum memasuki kegiatan 

lapangan dan pengumpulan data di lapangan terdiri dari: 

a. Proses bimbingan  

b. Penyusunan kembali instrumen penelitian 

c. Pengumpulan data 

d. Analisis data  

e. Membuat kesimpulan 

Untuk lebih jelasnya dalam pengumpulan data penelitian dapat dilihat pada 

gambar langkah-langkah berikut ini 
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  Populasi   

     

  Sampel   

     

  Tes awal 

Keterampilan  

  

     

Model Pembelajaran TGFU  Model Pembelajaran TGT 

     

Keterampilan Permainan 

Tradisional (Post-Test) 

 Keterampilan Permainan 

Tradisional (Post-Test) 

     

  Pengolahan dan Analisi 

Data 

  

     

  Kesimpulan   

 

Gambar 3.1. Langkah-Langkah Pengumpulan Data 

 

G. Analisis Data 

1) Rata-rata dan Simpangan Baku 

Perhitungan rata-rata dan simpangan baku dengan menggunakan aplikasi 

Statistical Package for the Social Sciences (SPSS) versi 18. Tahapan 

penghitungan yang akan dilakukan dengan langkah-langkah sebagai berikut: klik 

Analyze>Descriptive Statistics >Descriptives> Masukan semua variabel ke kotak 

Variable(s) >Options> ceklis Mean dan Std. Deviation >Continue>OK. 

2) Uji Normalitas 

Uji normalitas salah satu uji prasyarat yang digunakan untuk mengetahui 

apakah data tersebut berdistribusi normal atau baik. Uji normalitas menggunakan 

kolmogorov-smirnov dengan bantuan Statistical Package for the Social 

Sciences(SPSS) versi 18. Tahapan penghitungan yang akan dilakukan dengan 

langkah-langkah sebagai berikut: klik Analyze>Nonparametric Tests >Legacy 

Dialogs > 1-Sample K-S > Masukan semua variabel ke kotak Test Variable List 

>OK. Format pengujiannya dengan membandingkan nilai probabilitas (p) atau 

signifikansi (Sig.) dengan derajat kebebasan (dk) α = 0,05. Uji kebermaknaannya 

sebagai berikut: 

a) Jika nilai Sig. atau P-value> 0,05 maka data dinyatakan normal. 

b) Jika nilai Sig. atau P-value< 0,05 maka data dinyatakan tidak normal. 
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3) Uji Homogenitas 

Uji homogenitas digunakan untuk mengetahui apakah suatu data atau 

sampel yang diambil berasal dari varian yang homogen atau tidak. Uji 

homogenitas dilakukan sebagai prasyarat dalam uji anova. Uji homogenitas 

menggunakan Lavene Statisticdengan bantuan Statistical Package for the Social 

Sciences (SPSS) versi 18. Tahapan penghitungan yang akan dilakukan dengan 

langkah-langkah sebagai berikut: klik Analyze>Compare Means>One-Way 

ANOVA> Masukan variabel ke kotak Dependent List > Masukan faktor ke kotak 

Factor >Options >Homogenity of variance test>Continue>OK. Format 

pengujiannya dengan membandingkan nilai probabilitas (p) atau signifikansi 

(Sig.) dengan derajat kebebasan (dk) α = 0,05. Uji kebermaknaannya sebagai 

berikut: 

a) Jika nilai Sig. atau P-value> 0,05 maka data dinyatakan homogen. 

b) Jika nilai Sig. atau P-value< 0,05 maka data dinyatakan tidak homogen. 

4) Uji Hipotesis 

Uji hipotesis yang digunakan dalam penelitian ini menggunakan uji 

ANOVA dua jalur dengan bantuan Statistical Package for the Social Sciences 

(SPSS) versi 18. Tahapan penghitungan yang akan dilakukan dengan langkah-

langkah sebagai berikut: Buka Tab Variable View: Buat 3 variabel dengan 

ketentuan sebagai berikut:  

a) Variabel independen: 1. "gender" dengan kategori tinggi dan rendah. 

Measure Nominal, Decimals=0, Type Numeric dan isi value: 1= Tinggi, 2= 

Rendah. 

b) Variabel independen: 2. "Model Pembelajaran" dengan kategori TGFU dan 

TGT.Measure Nominal, Decimals=0, Type Numeric dan isi value: 1= 

Cooperatif Learning, 2=Konvensional. 

c) Variabel dependen: "keterampilan permainan tradisional", Decimals=0, 

Measure Scale, Type Numeric.   

Setelah langkah-langkah di atas lalu klik Analyze>General Linear 

Model>Univariate> Masukan data keterampilan permainan tradisionalke kotak 

Dependent Variable, masukan variabel gender dan model pembelajaran ke kotak 

Fixedfactor(s) > klik Plot masukkan gender ke kotak Horizontal Axis dan model 
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pembelajaran nke kotak Separate Lines>add>continue> klikPost Hoc, masukkan 

model pembelajara ke kotak Post Hoc Test for > Tukey >continue> klik OK. Uji 

kebermaknaannya sebagai berikut: 

a) Corrected Model: Pengaruh Semua Variabel independen (gender, model 

pembelajaran dan Interaksi gender dengaan model pembelajaran atau "gender 

*model pembelajaran") secara bersama-sama terhadap variabel dependen 

(keterampilan permainan tradisional). Apabila Signifikansi (Sig.) < 0,05 

(Alfa) = Signifikan.  

b) Intercept: Nilai perubahan variabel dependen tanpa perlu dipengaruhi 

keberadaan variabel independen, artinya tanpa ada pengaruh variabel 

independen, variabel dependen dapat berubah nilainya. Apabila Signifikansi 

(Sig.) < 0,05 (Alfa) = Signifikan. 

c) Keterampilan permainan tradisional: Pengaruh keterampilan permainan 

tradisionalterhadap gender. Apabila Signifikansi (Sig.) < 0,05 (Alfa)= 

Signifikan.  

d) Model Pembelajaran: Pengaruh model pembelajaran terhadap data 

keterampilan permainan tradisional. Apabila Signifikansi (Sig.) <0,05 (Alfa)= 

Signifikan. 

e) Kemampuan gender*model pembelajaran: Pengaruh kemampuan 

gender*model pembelajaran terhadap data keterampilan permainan 

tradisional. Apabila Signifikansi (Sig.) <0,05 (Alfa)= Signifikan. 

f) Error: Nilai Error model, semakin kecil maka model semakin baik. 

Dengan demikian berdasarkan tata cara peerhitungan hipotesis statistik di 

atas yang diajukan dalam penelitian ini adalah sebagai berikut: 

1) Ho : µA1   = µA2 

Hi  : µA1   > µA2 

2) Ho : Interaksi A x B = µA2 

Hi  : Interaksi A x B ≠ µA2 

3) Ho : µA1B1  = µA2B1 

Hi  : µA1B1  > µA2B1 

4) Ho : µA1B2  = µA2B2 

Hi  : µA1B2  > µA2B2 
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Keterangan: 

µA1 : Rata-rata keterampilan permainan tradisional kelompok siswa 

dengan model pembelajaran TGFU. 

µA2 : Rata-rata keterampilan permainan tradisional kelompok siswa 

dengan model pembelajaran TGT. 

µA1B1 : Rata-rata keterampilan permainan tradisional kelompok siswa laki-

laki dan perempuan dengan model pembelajaran TGFU. 

µA2B1 : Rata-rata keterampilan permainan tradisional kelompok siswa laki-

laki dengan model pembelajaran TGT. 

µA1B2 : Rata-rata keterampilan permainan tradisional kelompok siswa 

perempuan dengan model TGFU. 

µA2B2   : Rata-rata permainan tradisional kelompok siswa perempuan dengan 

model pembelajaran TGT. 

5) Uji Validitas dan Reabilitas Instrumen  

Sebuah penelitian ilmiah memerlukan suatu instrumen guna memperoleh 

data yang diperlukan. Instrumen tersebut tentunya harus sesuai dengan kebutuhan 

penelitian. Selain itu juga instrumen tersebut sebelumnya perlu dilakukan uji coba 

terlebih dahulu. Uji validitas dan reabilitas instrumen berguna untuk menguji 

standarisasi instrumen yang akan digunakan dalam sebuah penelitian. Berdasarkan 

hal tersebut berikut ini peneliti paparkan hasil uji coba instrumen sebagai berikut: 
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Tabel 3.8 Uji Validitas Instrumen Keterampilan Permainan Tradisional 

 
Corrected Item-Total 

Correlation 
Nilai r Keputusan 

Item 1 0,489 0,30 Valid 

Item 2 0,330 0,30 Valid 

Item 3 0,606 0,30 Valid 

Item 4 0,336 0,30 Valid 

Item 5 0,556 0,30 Valid 

Item 6 0,638 0,30 Valid 

Item 7 0,316 0,30 Valid 

Item 8 0,659 0,30 Valid 

Item 9 0,512 0,30 Valid 

Item 10 0,491 0,30 Valid 

Rata-rata 0.493  Valid 

Tabel di atas menunjukan hasil pengujian validitas instrumen dengan 

menggunakan nilai corrected item-total correlation. Untuk menentukan item 

dalam instrumen valid atau tidak, dilakukan perbandingan pada nilai corrected 

item-total correlation. Menurut Azwar (2009) menyatakan “Atau jika melakukan 

penilaian langsung terhadap koefisien korelasi, bisa digunakan batas nilai minimal 

korelasi 0,30. Semua item yang mencapai koefisien korelasi minimal 0,30 daya 

pembedanya dianggap memuaskan. Pada hasil uji validtas di atas, diketahui 

bahwa seluruh item instrumen keterampilan permainan tradisional memiliki nilai r 

> 0,30 dengan nilai korelasi rata-rata = 0,493 > 0,30. Maka seluruh item 

instrumen keterampilan permainan tradisional dapat dinyatakan valid. 

Tabel 3.9 Uji Reabilitas Instrumen Keterampilan Permainan Tradisional 

N Cronbach's Alpha Keputusan 

10 0,806 Reliabel 

Azwar (2009) menyatakan “Reabilitas dinyatakan oleh koefisien reabilitas yang 

angkanya berada dalam rentan dari 0 sampai dengan 1,00. Semakin tinggi 

koefosien reabilitas mendekati 1,00 berarti semakin tinggi reabilitasnya.” Pada 

tabel hasil uji reabilitas di atas menunjukan bahwa nilai Cronbach's Alpha = 0,806 

mendekati 1,00. Maka dapat diartikan bahwa instrumen keterampilan permainan 
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tradisional memiliki nilai reabilitas tinggi. Setelah mengetahui hasil uji validitas 

dan reabilitas instrumen, keduanya memiliki nilai di atas standar. Maka dengan itu 

intrumen keterampilan permainan tradisional dapat digunakan. 

 


